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Kapitola 1

Kerio Connector for BlackBerry

Kerio Connector for BlackBerry je speciální modul, který zajišt’uje spolupráci mezi aplikací

Kerio Connect a BlackBerry Enterprise Serverem. Tento modul umožňuje, aby data, která

uživatelé poťrebují ke své práci, byla dostupná i z jejich zařízení BlackBerry. Těmito daty

jsou myšleny poštovní složky, kalendáře, úkoly, kontakty a poznámky.

Obrázek 1.1 znázorňuje průběh komunikace mezi aplikací Kerio Connect, BlackBerry Enter-

prise Server, modulem Kerio Connector for BlackBerry a zařízeními BlackBerry.

Kerio Connector for BlackBerry komunikuje se serverem Kerio Connect protokolem HTTPS

(port 443). Kerio Connector for BlackBerry předává zprávy BlackBerry Enterprise Serveru přes

rozhraní MAPI. BlackBerry Enterprise Server pak dále zprávy synchronizuje se zařízením

BlackBerry.

Stejně probíhá synchronizace i opačným směrem.

Obrázek 1.1 Průběh komunikace

Upozornění:

Při instalaci se Kerio Connector for BlackBerry připojuje na server Kerio Connect protokoly

TCP/UDP na portu 44337.

Následující komunikace při synchronizaci probíhá obdobně, avšak zabezpečeným

protokolem HTTPS na portu 443.

Zkontrolujte, zda počítač s modulem Kerio Connector for BlackBerry má povolen přístup na

server Kerio Connect.
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Kapitola 2

Systémové požadavky

2.1 Definice pojmů

Pro snadnější postup při instalaci si nadefinujeme některé pojmy:

• Účet Windows_Administrator — administrátorský účet, kterým se přihlašujeme

k počítači, kde instalujeme BlackBerry Enterprise Server a Kerio Connector for Black-

Berry.

Poznámka:

Jelikož veškeré (i budoucí) aktualizace BlackBerry Enterprise Serveru a modulu Kerio

Connector for BlackBerry musí probíhat pod tímto účtem/heslem, doporučujeme

použít lokální účet s právy administrátora, na který se nebude vztahovat doménová

politika na změnu hesla.

Změníme-li tomuto účtu heslo, komunikace mezi BlackBerry Enterprise Serverem,

modulem Kerio Connector for BlackBerry a aplikací Kerio Connect se přeruší.

• Účet AD_User — účet uživatele z Active Directory.

• Účet BES_Administrator — administrátorský účet k BlackBerry Administration Service.

(Účet vytvoříme během instalace BlackBerry Enterprise Serveru).

• Účet Connect_Administrator — administrátorský účet k aplikaci Kerio Connect.

Upozornění:

Pro lepší orientaci v textu jsme zvolili jména účtů popisná. Pro svoji poťrebu použijte

uživatelská jména dle svých standardů.

Výjimku tvoří účet BES_Administrator. Při instalaci BlackBerry Enterprise Serveru je tento

účet vytvořen s pevně daným jménem admin, které nelze změnit.

2.2 Hardwarové a softwarové požadavky

Doporučená konfigurace počítače, na který mají být nainstalovány BlackBerry Enterprise Server

(BES), Kerio Connector for BlackBerry a případně i Kerio Connect:

• CPU 2 GHz, 2 GB RAM pro BES server (je-li nainstalovaný na stejném počítači i Kerio

Connect, viz manuál).

http://manuals.kerio.com/connect/adminguide/cz/sect-systemparam
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Poznámka:

Kerio Technologies doporučuje tuto minimální konfiguraci paměti:

• 100MB RAM pro modul Kerio Connector for BlackBerry,

• 30MB RAM pro každého uživatele zařízení BlackBerry.

Upozornění:

Maximální doporučený počet aktivních zařízení BlackBerry je 50.

• Operační systém Microsoft Windows.

Operační systémy podporované modulem Kerio Connector for BlackBerry naleznete

na stránkách společnosti Kerio Technologies.

Operační systémy podporované aplikací Kerio Connect naleznete na stránkách

společnosti Kerio Technologies.

Operační systémy doporučené společností Research In Motion Limited naleznete na

http://docs.blackberry.com/en/admin/deliverables/18763/.

• Administrátorský účet na tomto počítači (účet Windows_Administrator, viz sekce 2.1).

• Active Directory.

Poznámka:

Adresářová služba Active Directory je vyžadována pouze pro instalaci BES serveru.

Nemusí obsahovat žádné aktivní uživatele.

• Instalační balíček BlackBerry Enterprise Server pro Exchange verze 5.0 nebo novější

nebo BlackBerry Enterprise Server Express verze 5.0 nebo novější a příslušné licenční

klíče.

Instalační balík a licenční klíče BlackBerry Enterprise Server Express je možné získat

zde:

http://na.blackberry.com/eng/services/business/server/express/

• Nainstalovanou aplikaci Kerio Connect verze 7.1.0 a pozdější.

• Administrátorský přístup k aplikaci Kerio Connect (účet Connect_Administrator,

viz 2.1).

• Instalační soubor modulu Kerio Connector for BlackBerry stejné verze jako Kerio Con-

nect.

http://www.kerio.com/connect/requirements/
http://www.kerio.com/connect/requirements/
http://www.kerio.com/connect/requirements
http://www.kerio.com/connect/requirements
http://docs.blackberry.com/en/admin/deliverables/18763/
http://na.blackberry.com/eng/services/business/server/express/
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Kapitola 3

Pořadí instalace

Abychom mohli začít synchronizovat zařízení BlackBerry s aplikací Kerio Connect, je ťreba

provést instalace v tomto pořadí:

1. Kerio Connect 7.1 a vyšší

2. Kerio Connector for BlackBerry

Poznámka:

Mějme na paměti, že Kerio Connector for BlackBerry je ťreba nainstalovat na stejný počítač

jako BlackBerry Enterprise Server. Proto je nutné instalaci Kerio Connectoru for BlackBerry

spustit na počítači s verzí Microsoft Windows podporovanou BlackBerry Enterprise Serve-

rem (viz sekce 2).

Upozornění:

Pokud nemáme v síti Windows Domain Controller, je možné ho udělat z počítače,

na který bude nainstalován Kerio Connector for BlackBerry a BlackBerry Enterprise

Server.

3. BlackBerry Enterprise Server

Pokud již máme BlackBerry Enterprise Server nainstalovaný a/nebo připojený k Exchange

serveru, je ťreba ho kompletně odinstalovat (včetně SQL databází).

Přestože mohou být BlackBerry Enterprise Server a Kerio Connect instalovány na jednom

počítači, doporučujeme z důvodu výkonnosti a nároků na operační pamět’ instalace rozdělit.

Následující kapitoly a sekce nabízejí dva scénáře: doporučenou instalaci na dva počítače a

instalaci všech komponent na jeden počítač.

Upozornění:

Na BlackBerry Enterprise Server není poskytována technická podpora ze strany společnosti

Kerio Technologies. V případě jakýchkoliv problémů s BES serverem se obrat’te na

technickou podporu výrobce (Research In Motion Limited).
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3.1 Instalace na dva počítače

Obrázek 3.1 Instalace na 2 počítače

Abychom mohli začít synchronizovat zařízení BlackBerry s aplikací Kerio Connect,

doporučujeme při instalaci na dva počítače postupovat v tomto pořadí (předpokládejme, že

operační systémy jsou již nainstalovány, pro podporované verze viz kapitola 2.2):

Počítač 1

1. Kerio Connect 7.1 a pozdější (detailní popis instalace naleznete v kapitole 5).

Počítač 2

1. Active Directory (detailní popis instalace naleznete v kapitole 4).

Poznámka:

Active Directory instalujeme pouze tehdy, nemáme-li tuto adresářovou službu

k dispozici. V opačném případě stačí počítač přidat do existující AD domény.

2. Kerio Connector for BlackBerry shodné verze jako Kerio Connect (detailní popis

instalace naleznete v kapitole 6).

3. BlackBerry Enterprise Server (detailní popis instalace naleznete v kapitole 7).

3.2 Instalace na jeden počítač

Abychom mohli začít synchronizovat zařízení BlackBerry s aplikací Kerio Connect,

doporučujeme při instalaci na jeden počítač postupovat v tomto pořadí:

1. Operační systém Microsoft Windows (pro podporované verze viz kapitola 2.2).

2. Active Directory (detailní popis instalace naleznete v kapitole 4).
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Obrázek 3.2 Instalace na 1 počítač

Poznámka:

Active Directory instalujeme pouze tehdy, nemáme-li tuto adresářovou službu k dispozici.

V opačném případě stačí počítač přidat do existující AD domény.

3. Kerio Connect 7.1 a pozdější (detailní popis instalace naleznete v kapitole 5).

4. Kerio Connector for BlackBerry shodné verze jako Kerio Connect (detailní popis instalace

naleznete v kapitole 6).

5. BlackBerry Enterprise Server (detailní popis instalace naleznete v kapitole 7).
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Kapitola 4

Instalace Active Directory

Pro instalaci BlackBerry Enterprise Serveru je ťreba mít nainstalovanou adresářovou službu

Active Directory.

Máme-li již Active Directory k dispozici:

1. Ujistíme se, že počítač, kam budeme instalovat Kerio Connector for BlackBerry a Black-

Berry Enterprise Server, je součástí AD domény.

2. Pokračujeme instalací aplikace Kerio Connect (viz kapitola 5).

Nemáme-li Active Directory k dispozici, použijeme pro instalaci například příkazu dcpromo

v příkazovém řádku Microsoft Windows.

Poznámka:

Jelikož BlackBerry Enterprise Server poťrebuje Active Directory pouze během instalace, je

možné AD nainstalovat pouze dočasně.

Instalaci provedeme následovně:

1. Přihlásíme se do počítače administrátorským účtem Windows_Administrator.

Poznámka:

Jméno účtu Windows_Administrator je pouze ilustrativní (viz sekce 2.1).
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2. V příkazovém řádku spustíme průvodce příkazem dcpromo (viz obrázek 4.1).

Obrázek 4.1 Spuštění instalace Active Directory
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3. V dialogu Choose a Deployment Configuration založíme novou doménu v novém lese (Cre-

ate a new domain in a new forest), viz obrázek 4.2) a klikneme na Next.

Obrázek 4.2 Instalace Active Directory
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4. Napíšeme jméno domény (viz obrázek 4.3) a klikneme na Next.

Obrázek 4.3 Instalace Active Directory
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5. Napíšeme jméno domény NetBIOS (viz obrázek 4.4) a klikneme na Next.

Obrázek 4.4 Instalace Active Directory
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6. Vybereme zpětnou kompatibilitu s předchozími operačními systémy (viz obrázek 4.5) a

pokračujeme dále tlačítkem Next.

Obrázek 4.5 Instalace Active Directory
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7. V dalším kroku vybereme instalaci DNS serveru a globálního katalogu a klikneme na Next.

Obrázek 4.6 Instalace Active Directory
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8. Zadáme cestu pro ukládání databáze a záznamů Active Directory a adresáře SYSVOL (viz

obrázek 4.7).

Obrázek 4.7 Instalace Active Directory
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9. Nyní zadáme heslo pro obnovu adresářových služeb (viz obrázek 4.8) a pokračujeme

kliknutím na tlačítko Next.

Obrázek 4.8 Instalace Active Directory

10. Zkontrolujeme nastavení instalace, instalaci dokončíme a restartujeme počítač.
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Kapitola 5

Instalace aplikace Kerio Connect

Instalační balí̌cek Kerio Connect lze získat na produktových stránkách společnosti Kerio Tech-

nologies (http://www.kerio.cz/cz/connect/download/).

Aplikaci Kerio Connect nainstalujeme standardním způsobem.

Detailní informace o instalaci naleznete v manuálu.

Během instalace vytvoříme administrátorský účet (např. Connect_Administrator) — tento účet

použijeme při instalaci modulu Kerio Connector for BlackBerry.

Poznámka:

Jméno účtu Connect_Administrator je pouze ilustrativní (viz sekce 2.1).

http://www.kerio.cz/cz/connect/download/
http://manuals.kerio.com/connect/adminguide/cz/chap-installation


21

Kapitola 6

Instalace modulu Kerio Connector for BlackBerry

Instalační balíček Kerio Connector for BlackBerry lze získat na produktových stránkách

společnosti Kerio Technologies (http://www.kerio.cz/cz/connect/download/).

Při instalaci modulu Kerio Connector for BlackBerry postupujeme následovně:

1. Přihlásíme se do počítače administrátorským účtem Windows_Administrator.

Poznámka:

Jméno účtu Windows_Administrator je pouze ilustrativní (viz sekce 2.1).

2. Spustíme instalaci modulu Kerio Connector for BlackBerry.

3. Kerio Connector for BlackBerry vyžaduje instalaci rozhraní MAPI. MAPI (Messaging

Application Programming Interface) je univerzální softwarové rozhraní pro přenos zpráv,

které vyvinula společnost Microsoft. Není-li na počítači, instalační program ho sám

nabídne k nainstalování (viz obrázek 6.1).

MAPI nainstalujeme.

Obrázek 6.1 Instalace MAPI

http://www.kerio.cz/cz/connect/download/


Instalace modulu Kerio Connector for BlackBerry

22

4. Po skončení instalace MAPI pokračujeme instalací samotného modulu Kerio Connector for

BlackBerry.

Instalace probíhá běžným způsobem. Potvrdíme souhlas s licenčními podmínkami a

umístění modulu.

5. Vyplníme heslo k administrátorskému účtu na počítači (Windows_Administrator, viz

obrázek 6.2) a potvrdíme.

Poznámka:

Jméno účtu Windows_Administrator je pouze ilustrativní (viz sekce 2.1).

Obrázek 6.2 Instalace modulu Kerio Connector for BlackBerry
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6. Vyplníme jméno serveru a uživatelské jméno a heslo administrátora aplikace Kerio Con-

nect (účet Connect_Administrator, viz obrázek 6.3) a potvrdíme.

Poznámka:

Jméno účtu Connect_Administrator je pouze ilustrativní (viz sekce 2.1).

Obrázek 6.3 Instalace modulu Kerio Connector for BlackBerry

Poznámka:

Uživatelské jméno a heslo administrátora aplikace Kerio Connect (uživatel Con-

nect_Administrator) jsou použity pouze pro instalaci a nejsou během instalace nikam

ukládány.

7. Instalaci dokončíme.

Upozornění:

Při instalaci komunikuje Kerio Connector for BlackBerry s aplikací Kerio Connect protokoly

TCP/UDP na portu 44337.

Následující komunikace při synchronizaci probíhá zabezpečeným protokolem HTTPS na

portu 443.

Zkontrolujte, zda počítač, kde instalujete Kerio Connector for BlackBerry, má povolen

přístup na server Kerio Connect.

Při instalaci modulu Kerio Connector for BlackBerry se automaticky vytvoří v aplikaci Kerio

Connect skrytý administrátorský účet, který Kerio Connector for BlackBerry využívá pro

přístup k datům v Kerio Connect.
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Aby tato komunikace byla dostatečně bezpečná:

• je pro tento účet vygenerováno silně zabezpečené heslo,

Upozornění:

Důrazně nedoporučujeme heslo tohoto účtu měnit.

• Kerio Connect omezí IP adresy, ze kterých bude moci Kerio Connector for BlackBerry

s aplikací Kerio Connect komunikovat.

Upozornění:

Přecházíme-li do jiného segmentu sítě, je nutné Kerio Connector for

BlackBerry přeinstalovat (viz kapitola 10.5).
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Kapitola 7

Instalace BlackBerry Enterprise Server Express

Následující kapitola popisuje instalaci BlackBerry Enterprise Server Express verze 5.0.2.

Instalační balíček BlackBerry Enterprise Serveru Express lze získat

na produktových stránkách společnosti Research In Motion Limited

(http://na.blackberry.com/eng/services/business/server/express/).

Upozornění:

Na BlackBerry Enterprise Server není ze strany společnosti Kerio Technologies poskytována

technická podpora. V případě jakýchkoliv problémů s BES serverem se obrat’te na

technickou podporu výrobce (Research In Motion Limited).

Základní instalaci BlackBerry Enterprise Serveru provedeme dle následujících kroků:

1. Přihlásíme se do počítače administrátorským účtem Windows_Administrator.

Poznámka:

Jméno účtu Windows_Administrator je pouze ilustrativní (viz sekce 2.1).

2. Rozbalíme instalační balíček BlackBerry Enterprise Serveru a spustíme instalaci.

3. Instalační program sám nadetekuje doménu a jméno účtu administrátora, pod kterým

jsme na počítači přihlášení (viz obrázek 7.1).

Obrázek 7.1 Instalace BES serveru

http://na.blackberry.com/eng/services/business/server/express/
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Pro pokračování v instalaci klikneme na Continue Installation.

4. Potvrdíme licenční podmínky a pokračujeme kliknutím na tlačítko Next.

Obrázek 7.2 Instalace BES serveru



27

5. Zvolíme vytvoření nové konfigurační databáze (viz obrázek 7.3). Pokračujeme kliknutím

na tlačítko Next.

Obrázek 7.3 Instalace BES serveru
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6. Zvolíme instalaci celého serveru a dalších komponent (viz obrázek 7.4) a pokračujeme

kliknutím na tlačítko Next.

Obrázek 7.4 Instalace BES serveru

7. Na následující obrazovce zkontrolujeme instalační seznam.

Je-li vše v pořádku, klikneme na tlačítko Next.

Jsme-li k počítači přihlášeni jako doménový administrátor (tzn. účet

Windows_Administrator není lokálním účtem s právy administrátora), instalační

program zobrazí varovnou hlášku, že uživatelský účet, pod kterým jste přihlášeni, paťrí

do skupiny doménových administrátorů BES serveru (viz obrázek 7.5). Pokračujeme

tlačítkem Yes.
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Obrázek 7.5 Instalace BES serveru

8. Dalším krokem je instalace databázového serveru (obrázek 7.6). Zvolíme příslušnou volbu

a klikneme na Next.

Obrázek 7.6 Instalace BES serveru
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9. V následujícím dialogovém okně vyplníme heslo administrátorského účtu

Windows_Administrator, zvolíme cestu k instalační složce a složce k ukládání

záznamů, zvolíme jméno BES serveru (viz obrázek 7.7).

Poznámka:

Jméno účtu Windows_Administrator je pouze ilustrativní (viz sekce 2.1).

Pokračujeme kliknutím na tlačítko Next.

Obrázek 7.7 Instalace BES serveru
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10. Další stránka instalačního průvodce zobrazí souhrnné informace o instalaci (viz

obrázek 7.8).

Chceme-li některé údaje změnit, použijeme tlačítko Back (Zpět). Jinak spustíme instalaci

tlačítkem Install.

Obrázek 7.8 Instalace BES serveru

11. Jsme-li během instalace požádáni o restart počítače, učiníme tak a opět se přihlásíme

účtem Windows_Administrator.

Poznámka:

Jméno účtu Windows_Administrator je pouze ilustrativní (viz sekce 2.1).
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12. Pokračujeme v instalaci BlackBerry Enterprise Serveru a doplníme informace o databázi

(viz obrázek 7.9):

• typ databáze (lokální, vzdálená),

• jméno databázového serveru, nastavení portů, cestu ke složkám pro uložení a

zálohu dat,

• typ ově̌rování (Windows, SQL).

Potvrdíme vytvoření nové databáze a pokračujeme dále tlačítkem Next.

Obrázek 7.9 Instalace BES serveru
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13. V dalším kroku doplníme licenční klíče (viz obrázek 7.10).

Licenční klíče získáme registrací na stránkách společnosti Research In Motion Ltd.

Obrázek 7.10 Instalace BES serveru

Správnost ově̌ríme tlačítky Verify a pokračujeme kliknutím na tlačítko Next.
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14. Nastavíme správu BES serveru (viz obrázek 7.11).

Obrázek 7.11 Instalace BES serveru
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15. Vyplníme uživatelské jméno a heslo uživatele z Active Directory — účet AD_User (viz

obrázek 7.12).

Obrázek 7.12 Instalace BES serveru
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16. Vytvoříme účet pro BlackBerry Administration Service — účet BES_Administrator (viz

obrázek 7.13).

Upozornění:

Pro lepší orientaci v textu jsme zvolili jméno účtu popisné. Při instalaci BlackBerry

Enterprise Serveru je tento účet vytvořen s pevně daným jménem admin, které

nelze změnit.

Obrázek 7.13 Instalace BES serveru
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17. V dalším kroku průvodce spustíme služby BlackBerry Enterprise Serveru.

Kliknutím na tlačítko Next se nám zobrazí adresy BlackBerry Administration Service a

BlackBerry Desktop Manageru (viz obrázek 7.14).

Pro zapamatování adres můžeme zaškrtnout volbu Export the console addresses to a .txt

file (Exportovat adresy do textového souboru).

Obrázek 7.14 Instalace BES serveru

18. Průvodce ukončíme tlačítkem Finish.

Pokud jsme zvolili export adres do souboru, zadáme také cestu pro uložení.
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Kapitola 8

BlackBerry Enterprise Server (Express)

8.1 Začínáme s BlackBerry Enterprise Server (Express)

Následující sekce popisují nastavení pro BlackBerry Enterprise Server Express verze 5.0.2.

8.1.1 P̌rístup k BlackBerry Administration Service

BlackBerry Administration Service je webová konzole pro správu BES serveru.

Správu můžeme otevřít v následujících prohlížečích (dle doporučení RIM, více informací

naleznete na http://docs.blackberry.com/en/admin/deliverables/18763/):

• Microsoft Internet Explorer 7 a 8,

• Firefox 3.6,

• Safari 4 for Mac,

• Google Chrome 4.

Poznámka:

Chceme-li zǎrízení připojit pomocí USB kabelu, je nutné použít prohlížeč Internet Explorer

kvůli podpoře ovládacích prvků ActiveX.

BlackBerry Administration Service nalezneme na adrese:

https://pocitac_s_BES_serverem:port/webconsole/app/

Příklad: https://bes-server.company.com:3443/webconsole/app/

Do BlackBerry Administration Service se primárně přihlásíme účtem BES_Administrator (viz

kapitola 2.1).

8.1.2 P̌rístup k BlackBerry Web Desktop Manager

BlackBerry Web Desktop Manager je webová aplikace, která uživatelům umožňuje nastavení

synchronizace zařízení.

Aplikaci můžeme otevřít v následujících prohlížečích (dle doporučení RIM, více informací

naleznete na http://docs.blackberry.com/en/admin/deliverables/18763/):

• Microsoft Internet Explorer 7 a 8,

• Firefox 3.6,

http://docs.blackberry.com/en/admin/deliverables/18763/
http://docs.blackberry.com/en/admin/deliverables/18763/
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• Safari 4 for Mac,

• Google Chrome 4.

Poznámka:

Chceme-li zǎrízení připojit pomocí USB kabelu, je nutné použít prohlížeč Internet Explorer

kvůli podpoře ovládacích prvků ActiveX.

BlackBerry Web Desktop Manager nalezneme na adrese:

https://pocitac_s_BES_serverem:port/webdesktop/

Příklad: https://bes-server.company.com:3443/webdesktop/

Jsou-li uživatelé mapování z Active Directory, přihlásí se do Web Desktop Manageru

jménem/heslem z Active Directory.

V BlackBerry Administration Service lze také v nastavení uživatele zadat jméno a heslo pro

přístup k Web Desktop Manageru.

8.1.3 Vytvoření uživatele na BES serveru

1. Připojíme se k BlackBerry Administration Service (viz kapitola 8.1.1).

2. Přihlásíme se k účtu uživatelským jménem a heslem vytvořeným během instalace (uživatel

BES_Administrator, viz obrázek 8.1).

Upozornění:

Pro lepší orientaci v textu jsme zvolili jméno účtu popisné. Při instalaci BlackBerry

Enterprise Serveru je tento účet vytvořen s pevně daným jménem admin, které

nelze změnit.

3. Zvolíme Create User . Zadáme kritéria pro zobrazení uživatelů aplikace Kerio Connect.

V seznamu zobrazených uživatelů vybereme ty, které chceme přidat, a stiskneme Conti-

nue.

4. Volbou Create user with activation password vytvoříme uživatele s aktivačním heslem.

Utvoříme aktivační heslo.
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Obrázek 8.1 BES Administration Service — přihlašovací stránka

Poznámka:

Jelikož se aktivační heslo používá pouze pro aktivaci zařízení (tj. pro spárování zařízení

BlackBerry a BES serveru a nastavení synchronizace), není ťreba zadávat heslo zvláště

zabezpečené.

5. Pro ukončení klikneme na Create user .

Kerio Connector for BlackBerry dostane pokyn od BES serveru a stáhne následující složky

uživatelského účtu:

• Doručená pošta,

• Odeslaná pošta,

• Kalendář,

• Kontakty,

• Úkoly,

• Poznámky.

Zpracování požadavku na aktivaci může nějakou dobu trvat.

8.1.4 Aktivace zǎrízení BlackBerry

1. V zařízení BlackBerry otevřeme aplikaci Options a vybereme Advanced Options → Enter-

prise Activation.

2. Zadáme e-mailovou adresu uživatele, aktivační heslo a jméno BES serveru. Klikneme na

Activate.
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Do složky s doručenou poštou v aplikaci Kerio Connect je zaslán e-mail ve speciálním

formátu. Tento e-mail nemažte ani neměňte. BES server si tento e-mail přečte a zahájí

aktivaci.

Poznámka:

Ujistěte se, že žádný z uživatelských filtrů pošty nepřesune tento e-mail do jiné složky.

Podrobný návod najdete na stránkách společnosti Research In Motion Limited:

http://uk.blackberry.com/support/enterpriseactivation/

Další způsoby aktivace jsou popsány na následujícím odkazu:

http://docs.blackberry.com/en/admin/deliverables/18778/ (Assigning BlackBerry devices

to users)

8.2 Práce s BlackBerry Enterprise Server

8.2.1 Kontrola Server Routing Protocol (SRP) a nastavení SRP ID

Přihlásíme se do rozhraní BlackBerry Administration Service (viz sekce 8.1.1).

Přepneme se do sekce Servers and Components → BlackBerry Solution Topology → Component

View → BlackBerry Enterprise Server → <instance name>.

Kontrola, zda je SRP protokol správně nastaven

1. Klikneme na Edit instance.

2. Přepneme se na stránku Instance Information.

3. Zkontrolujeme, zda je zobrazená hodnota stavu SRP protokolu Connected.

Není-li SRP připojen, nebudou žádná data doručována z/do zařízení.

Nastavení SRP ID

1. Klikneme na Edit instance.

2. Přepneme se na stránku Instance Information.

3. V sekci SRP Information vepíšeme informace o SRP ID a Authentication Key.

4. Klikneme na Save all a uložíme nastavení.

8.2.2 Aktivace S/MIME zpráv

Synchronizace S/MIME zpráv z/do zařízení je standardně na BES serveru zakázána.

Chceme-li ji povolit, postupujeme následovně:

1. Přihlásíme se do BlackBerry Administration Service (viz sekce 8.1.1).

2. Přepneme se do sekce Servers and Components → BlackBerry Solution Topology → Compo-

nent View → Email → <instance name>.

3. Klikneme na Edit instance.

http://uk.blackberry.com/support/enterpriseactivation/
http://docs.blackberry.com/en/admin/deliverables/18777/Assigning_BB_devices_to_user_accounts_513525_11.jsp
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4. Na stránce Messaging v sekci Security settings nastavíme položku Turn on S/MIME message

processing na hodnotu True.

5. Klikneme na Save all a uložíme nastavení.

8.2.3 Výběr mailových složek pro synchronizaci se zǎrízením BlackBerry

Standardně jsou synchronizovány složky Doručená pošta a Odeslaná pošta.

Chceme-li synchronizovat jiné složky, postupujeme následovně:

1. Přihlásíme se do BlackBerry Web Desktop Manager (viz sekce 8.1.2).

2. Přepneme se do sekce Email Settings → Redirection Folders.

3. Vybereme požadované složky.

4. Klikneme na Save a uložíme nastavení.

8.2.4 Výběr složek kontaktů pro synchronizaci se zǎrízením BlackBerry

Standardně jsou synchronizovány všechny složky s kontakty.

Chceme-li nastavení změnit, postupujeme následovně:

1. Přihlásíme se do BlackBerry Web Desktop Manager (viz sekce 8.1.2).

2. Přepneme se do sekce Email Settings → Contact Folders.

3. Vybereme požadované složky.

4. Klikneme na Save a uložíme nastavení.

8.2.5 Synchronizace smazaných zpráv ze zǎrízení na server

Standardně zůstává zpráva smazaná v zařízení BlackBerry na serveru nezměněná. Chceme-li

toto chování změnit, postupujeme následovně:

1. Na zařízení BlackBerry se přepneme do aplikace Message.

2. Přepneme se do Menu → Options → Emails Reconciliation.

3. Položku Delete on nastavíme na Mailbox & Handheld nebo Prompt.

4. Klikneme na Save a uložíme nastavení.
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Kapitola 9

Aktualizace

Verze modulu Kerio Connector for BlackBerry se musí shodovat s verzí aplikace Kerio Connect.

Proto je ťreba po aktualizaci aplikace Kerio Connect zaktualizovat na shodnou verzi také Kerio

Connector for BlackBerry.

Upgrade nových verzí Kerio Connectoru for BlackBerry se neprovádí automaticky. Chcete-li

provést upgrade, stačí spustit instalační balík nové verze.

Instalační balíček Kerio Connectoru for BlackBerry lze získat na produktových stránkách

společnosti Kerio Technologies (http://www.kerio.cz/cz/connect/download/).

Instalační program automaticky rozpozná adresář, v němž je stávající verze nainstalována,

zastaví spuštěné komponenty a služby, a nahradí příslušné soubory novými. Přitom zůstanou

zachována veškerá nastavení i uložené zprávy. V tomto případě se nedoporučuje měnit

nabízený instalační adresář!

http://www.kerio.cz/cz/connect/download/
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Kapitola 10

Řešení problémů

10.1 Záznamy

Při řešení problémů nám mohou pomoci záznamy.

10.1.1 Záznamy aplikace Kerio Connect

Při řešení případných problémů se synchronizací aplikace Kerio Connect se zařízením Black-

Berry může pomoci záznam komunikace mezi serverem a modulem Kerio Connector for Black-

Berry. Zaznamenávání informací lze spustit zapnutím příslušné volby v sekci Záznamy → De-

bug v Kerio Connect Administration:

1. Otevřeme v Kerio Connect Administration sekci Záznamy a vybereme záznam Debug.

2. V okně záznamu pravým tlačítkem myši otevřeme kontextové menu a vybereme položku

Zprávy.

3. Otevře se okno Zaznamenávané informace, kde zapneme příslušné záznamy (viz

obrázek 10.1).

Obrázek 10.1 Dialog pro nastavení záznamu Debug
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4. Změnu potvrdíme tlačítkem OK.

O záznamu Debug a jeho volbách se dozvíte více v manuálu.

10.1.2 Záznamy modulu Kerio Connector for BlackBerry

Cestu k záznamům Kerio Connector for BlackBerry nalezneme v Profile Configuration Utility

modulu Kerio Connector for BlackBerry.

V záložce Repair klikneme na tlačítko Advanced. V zobrazeném okně zaškrtneme položky,

které chceme do záznamů ukládat (viz obrázek 10.2).

Obrázek 10.2 Dialog pro nastavení záznamu modulu Kerio Connector for BlackBerry

http://manuals.kerio.com/connect/adminguide/cz/sect-debuglog
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Tlačítko Open file location otevře složku s uloženým souborem záznamu modulu Kerio Con-

nector for BlackBerry.

10.1.3 Záznamy BlackBerry Enterprise Server

Podrobné informace o záznamech BlackBerry Enterprise Serveru naleznete na stránkách Re-

search In Motion Limited (http://docs.blackberry.com/en/admin/deliverables/18777/).

Důležitou položkou pro řešení problémů při synchronizaci je komponenta BlackBerry Messa-

ging Agent (MAGT ).

10.2 Aktualizace Kerio Connect

Verze modulu Kerio Connector for BlackBerry se musí shodovat s verzí aplikace Kerio Con-

nect. Pokud aktualizujeme Kerio Connect, komunikace mezi aplikací a modulem se přeruší.

Neprobíhá-li synchronizace po určitou dobu (2 hodiny), odešle Kerio Connector for BlackBerry

všem uživatelům na jejich zařízení zprávu, aby kontaktovali svého administrátora.

Upgrade nových verzí Kerio Connectoru for BlackBerry se neprovádí automaticky. Proto je

ťreba po aktualizaci aplikace zaktualizovat také Kerio Connector for BlackBerry.

Pro informace o aktualizaci viz sekce 9.

10.3 Administrátorský účet na počítači

BlackBerry Enterprise Server i modul Kerio Connector for BlackBerry je nutné na počítač

nainstalovat pod shodným administrátorským účtem Windows_Administrator (viz sekce 2.1).

Neučiníme-li tak, synchronizace aplikace Kerio Connect se zařízením BlackBerry neproběhne

a je ťreba provést instalaci novou.

10.4 Nová instalace BlackBerry Enterprise Server Express

Licenční klíče BlackBerry Enterprise Server jsou vázány na konkrétní instalaci.

Rozhodneme-li se BlackBerry Enterprise Server Express přeinstalovat, doporučujeme vyžádat

si od společnosti Research In Motion Limited nové licenční klíče.

10.5 P̌rechod do jiného segmentu sítě

Kerio Connector for BlackBerry si vytvoří při instalaci speciální účet, kterým komunikuje

s aplikací Kerio Connect. Tento účet má silně zabezpečené heslo a automaticky se omezí IP

adresy, ze kterých Kerio Connector for BlackBerry s aplikací Kerio Connect komunikuje.

Přecházíme-li do jiného segmentu sítě, je ťreba Kerio Connector for BlackBerry přeinstalovat.

1. Zastavíme BlackBerry Enterprise Server.

2. Odinstalujeme Kerio Connector for BlackBerry.

http://docs.blackberry.com/en/admin/deliverables/18777/
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3. Nainstalujeme Kerio Connector for BlackBerry (viz kapitola 6).

4. Spustíme BlackBerry Enterprise Server.
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P̌ríloha A

Právní doložka

Microsoft, Windows, Windows NT, Windows Vista, Internet Explorer, Active Directory,

Outlook, ActiveSync, Entourage a Windows Mobile jsou registrované ochranné známky

společnosti Microsoft Corporation.

Apple, iCal, Mac OS, Safari, Tiger, Panther, Open Directory logo, Leopard a Snow

Leopard jsou registrované ochranné známky nebo ochranné známky společnosti Apple Inc.

Palm, Treo, Pre a VersaMail jsou registrované ochranné známky nebo ochranné známky

společnosti Palm, Inc.

Red Hat a Fedora jsou registrované ochranné známky nebo ochranné známky společnosti

Red Hat, Inc.

SUSE, openSUSE a openSUSE logo jsou registrované ochranné známky společnosti Novell

Inc.

Mozilla a Firefox jsou registrované ochranné známky společnosti Mozilla Foundation.

Linux je ochranná registrovaná známka Linuse Torvaldse.

Kerberos je ochranná známka Massachusetts Institute of Technology (MIT).

avast! je registrovaná ochranná známka společnosti ALWIL Software.

Symantec je ochranná známka společnosti Symantec Corporation.

eTrust je ochranná známka společnosti Computer Associates International, Inc.

ClamAV je ochranná známka společnosti Tomasz Kojm.

Cybertrust je registrovaná ochranná známka společnosti Cybertrust Holdings, Inc. a/nebo

jejích poboček.

Thawte je registrovaná ochranná známka společnosti VeriSign, Inc.

Entrust je registrovaná ochranná známka společnosti Entrust, Inc.

Sophos je registrovaná ochranná známka společnosti Sophos Plc.

ESET a NOD32 jsou registrované ochranné známky společnosti ESET, LLC.

AVG je registrovaná ochranná známka společnosti AVG Technologies.

NotifyLink je registrovaná ochranná známka společnosti Notify Technology Corporation.

BlackBerry je registrovaná ochranná známka společnosti Research In Motion Limited (RIM).

RoadSync je ochranná známka společnosti DataViz Inc.

Nokia a Mail for Exchange jsou registrované ochranné známky společnosti Nokia

Corporation.
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Symbian je ochranná známka společnosti Symbian Software Limited.

Sony Ericsson je registrovaná ochranná známka společnosti Sony Ericsson Mobile

Communications AB.

SpamAssassin je ochranná známka Apache Software Foundation.

SpamHAUS je registrovaná ochranná známka společnosti The Spamhaus Project Ltd.

Android a Nexus One je ochranná známka společnosti Google Inc. Užití této ochranné

známky je možné pouze v souladu s Google Permissions.

DROID je ochranná známka společnosti Lucasfilm Ltd. a jejich příbuzných společností.

Motorola je registrovaná ochranná známka společnosti Motorola, Inc.

http://www.google.com/permissions/index.html
http://www.google.com/permissions/index.html
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